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Introduction 
Converting audio from LPs and cassettes to a digital format is a time intensive 
process. Unlike ripping CDs to your computer, which takes mere seconds per CD, 
each album or cassette tape must be recorded in real time. A sixty minute album 
requires sixty minutes of record time, plus a few minutes of additional processing to 
lookup song titles, separate recordings into individual songs, and either burn a CD or 
save MP3s. This all sounds daunting, but you've got a secret weapon - this guide will 
help you simplify the recording process, using my hundreds of hours of experience to 
save you time.  
 
This guide offers a few straightforward solutions, designed to utilize hardware you 
already own whenever possible. The primary focus is on using one of two methods 
for converting your analog media to digital. The first relies on hardware in your home 
entertainment center. The second method assumes you will need to acquire some 
hardware to transfer your LPs and cassettes using one of the readily available 
software solutions. Whether your goal is preservation of rare vinyl records or the 
conversion of your favorite books on tape to mp3, I've outlined the process from 
start to finish. 
 
When the original version of this guide appeared in 2002, it was intended as a 
resource for people who want to listen to music from their record collection in places 
like their car or on their iPod. In my own experience, some of the best albums have 
never been re-released on CD, so converting vinyl was the only option I had to listen 
outside my house. My goal is to empower you to do the same using the best 
resources currently at your disposal. 

What this Guide Is Not 
This guide is not an attempt to make you an audiophile or convince you that you 
need to spend hundreds of dollars on new gear in order to make great sounding 
recordings of your music collection. I am one of those people who prefer listening to 
some kinds of music on vinyl. I'm not someone who believes I need to force my 
beliefs about music on you in order to get the most out of your collection. 

Which Conversion Method Should You Use? 
This guide provides several methods for converting vinyl records and cassettes to 
CDs and MP3s. You have the option to read straight through the guide and find the 
best option for your situation, but I've listed a few common scenarios below to help 
you get started as quickly as possible. If you fit the description of one of these 
common scenarios, simply click the link to jump to the section of the guide tailored 
to your needs. 
 
I have a turntable and records I'd like to convert to digital formats. 
 
I have some old records, but I don't own a turntable (or my turntable is no longer 
working). 
 
I have a cassette deck and some tapes I'd like to convert. 
 
I have tapes I'd like to convert but I don't own a cassette deck. 
 
I want to convert both my record collection and cassettes. 
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I Have a Turntable - Where do I Start? 
 
If you already own a turntable and a computer, you're most of the way to converting 
your old records to a digital format. The hardest part of the process is getting your 
stereo and your computer connected. You need two things to start recording those 
old records. The first thing you need is a cable to connect your home stereo to your 
computer. The second thing you need is audio recording software. 
 
After walking through the hardware connection, you'll be presented with a few 
software options. 
 

Hardware and Cabling Required 
 
The rest of this tutorial assumes steps in this section have been followed. Making 
hardware connections is software independent, following the same steps, regardless 
of which audio applications are installed on your PC. Some of these things may seem 
obvious; I'm covering them to be sure you don't miss anything. 
 

To transfer audio from your record collection:  
 
You need an amplifier with Line Out connectors and a turntable. Line Out connectors 
are usually labeled Rec Out in the Tape section on the back of your receiver. Newer 
amplifiers have a pair of one red and one white RCA jacks representing the right and 
left sides of the stereo spectrum. 
 
If your turntable has a built-in preamp, you don't 
need the amplifier. In this scenario, connect the 
RCA Line Out jacks from your pre-amped turntable 
to the Line In jack on your PC's sound card. 
 
For cassette recording, simply connect the Tape Out 
connectors on the back of your cassette player to 
the Line In jack your PC's sound card. 
 
Sound cards use 1/8-inch miniplugs for both input 
and output connections. When recording LPs or 
cassettes on your PC, connect the turntable or 
cassette deck to the Line In, which is frequently the 
black colored jack. 
 
  

 

 
 
Your Line Out connectors will 
look like the top red and white 
connectors shown here. 
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Cable Requirements 
 
To connect a turntable or cassette deck to your computer, purchase a cable 
consisting of two male RCA plugs on one end and a stereo miniplug (1/8-inch male 
plug) on the other end. The cables shown below each have different colored RCA 
connectors; the colors on the outside of the cable don't change how it works, so if 
the colors don't match the colors of the jacks in the back of your stereo, don't worry, 
they will still work.  

 
If your computer is an older laptop lacking a Line-In or microphone jack, a USB 
device like Griffin Technology's iMic will do the trick. iMic has two ports and a switch. 
The input port doubles as both a microphone and line-in connection. The switch is 
used to level the line, depending on how you use it. For recording cassettes and 
records, you want to use the line-in setting, not the microphone setting. 

 

 
  

 
 
Be sure to purchase a cable long enough to reach your computer and home stereo. 
(For long cable runs, an XLR cable, like the one on the left, is important for 
preventing line noise in your recording) 
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Check Your Connections 
 
To verify your connection works properly, play a record on the turntable, with both 
your amplifier and computer turned on, after all the connections have been made. 
Assuming all cables were connected properly, the record will play through your 
computer speakers.  
 

Troubleshooting 
 
If you don't hear anything: First, make sure your speakers are turned on. Next, 
check each cable, making sure all connections are fitted to their appropriate jacks. 
Finally, double-click the speaker icon in the Windows system tray. Check to make 
sure the volume control for your PC is not muted, with the slider somewhere above 
the bottom (volume 0) position. Check the Line In slider verifying the Mute checkbox 
is unchecked with the slider above the bottom position. 
 

 
 

Setting the Record Control 
This step is only relevant if you are using a USB audio device. 
 
One final step, relating to the Volume Control, is properly configuring your sound 
card for recording. Open the Volume Control, either by double-clicking the speaker 
icon in the task bar or by using Start/Control Panel/Sounds and Multimedia.  
 

 
Choose Options/Properties from the Volume Control menu. 
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Select the Recording option in the 
Adjust Volume For box and click OK. 
 
 The Volume Control panel is replaced 
by the Recording Control panel.  
Check the Line In Select checkbox, which 
makes the Line In your default source for 
sound recording. 
 
When you begin recording, adjust the 
level of your Line In as needed by 
moving the slider. 

 
 
 
 
 
 
 

Choosing Recording Software 
 
There are three primary choices to make when preparing to record. I highly 
recommend using a software application called Spin It Again. It's not free, but you 
save so much time that it quickly pays for itself. Spin It Again automates many of 
the steps that normally require babysitting with other options.  
 
To help make it more affordable, I negotiated to get a 20% discount on Spin It 
Again. Should you choose to use Spin It Again, use coupon code JAKECONVERT for 
the 20% discount. If you're on a tight budget, there is a free solution for converting 
using Audacity. The free way takes longer, but in this case you get what you pay for. 
I also outline several ways to do this with software you might have purchased in the 
past. I own all of the applications I talk about here and have used most of them for 
at least 5 years. I still find Spin It Again to be the easiest solution for the conversion 
process. The time saved is well worth the cost. 
 
When deciding which software to use, choose from the following options: 
 
Show me the easiest audio recording method using Spin It Again 
 
Show me the free audio recording method using Audacity 
 
Show me how to record audio with: 
Adobe Audtion 
Sound Forge 
Cool Edit 
Cakewalk Pyro 
 

http://www.jakeludington.com/offers/001853.html
http://store.esellerate.net/a.asp?c=0_SKU12470272665_AFL3758955766&coupon=JAKECONVERT
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Converting Vinyl LPs and Cassettes with Spin It Again 
 
I bill Spin It Again as the easiest way to convert your old records and cassettes to 
digital formats because it is. The software automatically breaks the side of an album 
into separate tracks. It automatically removes pops and clicks from the turntable. 
Spin It Again does an excellent job with tape hiss too. With very minor prompting, it 
automatically finds all the data about the songs on your album so that files are 
properly labeled. Most importantly, if CDs are your end goal, CD burning is built right 
in so you don't ever need to leave the application interface. Spin It Again is truly a 
one stop solution. 
 

Before you get started with recording, 
make sure you followed the previous 
steps for hooking up your turntable to 
your computer. Spin It Again has a 
helpful wizard that walks through this 
if you're still not sure you've done it 
correctly.  
 
The Recording Level Adjustment 
Wizard helps make sure you're 
recording audio at the proper level. 
Choose your sound card from the drop 
down menu and play a record on your 
turntable to help Spin It Again set 
levels correctly. 

 
Once you have the hardware setup and testing out of the way, it's time to start 
recording. Before dropping the needle on your record and hitting the record button, 
you want to set the Auto Pause time under the record button. Pick the time closest 
to the length of the side you are recording, so that you can walk away and do 
something else without worrying about recording a bunch of silence. For instance, if 
the side of the record is 28 minutes, choose 30 minutes as the Auto Pause After 
time. After setting this you're ready to record. 
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While recording is in progress, you can either wander away and do something else, 
or quickly look up the album info. Clicking the Type or Look Up Album Info button 
lets you provide partial information about the album, like the title and artist, making 
it easy for Spin It Again to supply the rest of the data about individual tracks. When 
side one is complete, pause the recording, turn the record over, and begin recording 
side two. Only after you've completed recording both sides should you click the Next 
button to move on to additional steps. 
 
With both sides are recorded, move on to the processing phase of the conversion. 
Here Spin It Again shows you the track start and stop it calculated for each track on 
the album. You can adjust these by moving a slider to make sure you don't cut off a 
track before it reaches the end. One trick here is to look for spaces with a completely 
flat line between tracks, which indicates the is no audio. The software finds the right 
start and stop points most of the time, but occasionally some minor intervention is 
required. 
 

 
 
Another key component of this processing phase is cleaning 
any pops and clicks introduced by the record player. Quickly 
preview some of the tracks from the album by selecting 
tracks in the top section of the Preview And Edit Your 
Recording window and clicking the preview button. If it 
sounds good to you, don't bother processing the track. If 
you think the files need some improvement, choose a 
processing option from the Cleaning & Effects Preset list.  
 
It's better to err on the side of light processing, so try 
settings like Vinyl Light Cleaning or Vinyl Declick & 
Decrackle before resorting to the Clean Anything! option. 
You can undo changes if the selection didn't solve the 

sound issue. There is no correct choice here. The idea is to choose a setting that 
makes your recording sound the way you like it. 
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When you finish 
cleaning the audio 
tracks and 
adjusting track 
breaks, it's time to 
create the files. 
Spin It Again 
offers several self 
explanatory 
options for 
creating CDs, 
audio files or both.  
 

 
 
Recording with an Ion USB Turntable 

If you don't currently own a standard 
turntable, a USB Turntable is an 
excellent option for converting vinyl 
records to MP3 or CD. I specifically 
picked the Ion TTUSB Turntable 
because it is widely available and 
competitively priced. More 
importantly, it sounds just like 
similarly priced home stereo units that 
lack USB. In addition to having a USB 
connection, the turntable also includes 
RCA connections for connecting to 
your home theater receiver. If you opt 
to purchase an Ion USB Turntable, 
there are two software options 

included in the box. One is the free Audacity product, which is detailed elsewhere in 
this guide. The second option in the box is ez Vinyl Converter, which is supposedly 
geared at beginners.  
 
While the interface of ez Vinyl Converter keeps options to a minimum, it takes 
frustration to the maximum by forcing you to sit and listen to the entire album and 
click a button to split individual tracks. You are also required to use iTunes and can't 
even install the software without first installing iTunes. 
 
I strongly recommend downloading Spin It Again and using it in conjunction with the 
Ion USB Turntable. You will be much happier with the experience despite spending a 
few extra dollars. After connecting the USB cable from the Ion to your PC, you can 
follow along with the steps in the section on Spin It Again. 
 
If you insist on using ez Vinyl Converter, some basic directions are provided below. 
 

Using ez Vinyl Converter with your Ion USB Turntable 
I've already indicated my dislike for the software bundled with the Ion turntable. 
Requiring iTunes for installation is a disservice to customers, especially since it only 
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needs iTunes so songs can be added to the iTunes library when recording completes. 
ez Vinyl Converter also fails to consider your time, requiring you to sit and monitor 
progress if you want individual song files when recording completes. Because I 
recommend the Ion as a hardware option for converting Vinyl, I feel duty bound to 
walk through the recording process using bundled software. 
 
Setting up the Ion hardware for recording is simple. Connect the power cord and 
plug it into the wall. Connect the USB cable and connect it to an open port on your 
computer. Windows XP and Windows Vista both recognize the turntable as an audio 
recording device automatically. Windows Vista users have one additional step prior to 
recording. You need to open the Control Panel > Hardware and Sound option, choose 
Manage Audio Devices and set the default format for the microphone USB Audio 
CODEC to 2 channel, 16 bit, 44100 Hz (CD Quality) on the advanced tab of the 
Properties dialog box. This last bit is necessary to make sure you are recording in 
stereo, not mono. 

 
After connecting the Ion turntable, you're 
ready to record. Launch ez Vinyl 
Converter and step through the wizard's 
minimal instructions. You will need to 
choose the turntable as your audio source 
before recording. Be sure to be there to 
click the new track button between songs, 
because there's no easy way to split songs 
later using ez Vinyl Converter. 
 
 
 

Once you have the recordings 
completed, locating song data requires 
you to enter most of the details yourself. 
I found attempting to locate specific 
track information to be an exercise in 
frustration using ez Vinyl Converter. The 
list of track options for a single song is 
tremendously long and even after 
picking the song title out of the list, you 
are left with filling in details manually in 
many cases.  
 

Once all the song data is entered for each 
track, ez Vinyl Converter exports songs to 
iTunes. Once in the iTunes music library, 
songs may be grouped for burning CDs, 
transferred to your iPod, or simply played 
from your computer. I have no problem 
with using iTunes as a music manager. I 
don't like not having the option to use 
Windows Media Player or something else as 
an alternative. 
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Do I need a Cassette Deck? 
One scenario I recently ran into was someone with a bunch of books on tape with no 
cassette deck. They acquired the audio books as part of an auction lot and wanted a 
way to convert them. If you're in the same boat, I highly recommend simply buying 
a stereo Walkman for $30 or less. Couple it with a cable with a miniplug on both 
ends (probably available at the same place you get the Walkman). Then jump back 
to the section on deciding which software to use. 

 
Audacity 
 
Audacity is a free multi-track recording tool. It's freely available online and also 
comes bundled with the Ion USB Turntable as the advanced audio editing solution. 
The software is currently available for Windows, Linux, FreeBSD, Classic Mac, and 
Mac OS X. Audacity performs identically on all platforms, making it the only audio 
editing solution that is truly cross-platform. Download Audacity to use this as your 
editing solution. 
 

Step 1: Launch Audacity 
Start/All 
Programs/Audacity/Audacity 
 

Step 2: Configure Audio 
Input/Output Preferences 
1. From the menu, 
select File and choose 
Preferences (Ctrl+P on the 
keyboard).  
 
2. Click the Audio I/O tab.  
 
3. Verify your soundcard as the 
device selected for both 
Playback Device and 
Recording Device. 
 
4. Check the Record in Stereo 
checkbox. 
 
 
 

 

http://topdrawerdownloads.com/download/104513
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Step 3: Set the Sample Rate  
1. Click on the Sample Rates tab. 
 
2. Select 44100.  
 
3. Click OK. 
 
 
 
 
 
 
 
 
 

 

Step 4: Recording  
1. Click the Record button 
(the red dot) and start 
playing your 
record/cassette. 
 
2. Click the Stop button 
(the yellow square) when 
recording is finished. 

Step 5: Preview the 
Recording 
Listen to at least a portion 
of the recording, to 
determine if the recording 
quality is satisfactory. If 
the level sounds good and 
the track is not distorted, proceed to the next step. 

Step 6: Create Multiple Tracks 
Either stop, and then restart the record process for each track on the LP, or record 
an entire side of the LP and divide the file to individual tracks when the side is 
finished recording. Make sure to save the raw audio track before splitting it, so you 
have a backup of the original. 
 
To create multiple tracks from one larger track, select the section you want to use 
for the new track, copy the section, and then paste it into a new file. 
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Step 7: Noise Reduction  
Audacity doesn't have a simple noise 
reduction wizard like some of the 
consumer applications outlined in this 
guide. Instead the process is performed 
manually. 
 
1. Zoom out the audio track by selecting 
the magnifying glass and clicking on the 
audio track, making it easy to select a 
section of silence in the track. (Notice all 
the noise appears to be on the right 
channel of this track.) 
 

2. Select the section with noise in the 
recording and launch the Noise 
Removal tool by clicking 
Effects/Noise Removal on the 
menu. 
 
3. Get the noise profile from this 
segment of audio by clicking the Get 
Noise Profile button. 
 
4. Once Audacity has a Noise Profile, 
select the entire audio track and click 
Remove Noise.  
 
5. Listen to the result. If the track 
sounds like all the tape his or excess 
noise from the LP is gone, save the 
file and continue to the next track. 

Step 8:SavingTracks 
Save your finished track by choosing File/Export As WAV. 
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Using Cakewalk Pyro 
Cakewalk is best known as a company that creates outstanding multi-track editing 
software for the home recording industry. Pyro takes some of the recording 
technology and puts a consumer face on it. Converting vinyl or cassettes to CD using 
Pyro is slightly different with each version. If you can track down a copy of Cakewalk 
Pyro 2003, it is highly competitive with Spin It Again for ease of use. Newer versions 
changed the interface and made the process more complicated. 

Step 1: Launch Cakewalk Pyro 
Start/All Programs/Cakewalk/Cakewalk Pyro/Cakewalk Pyro 
 

Step 2: Record 
Press the Record button to launch the Record window. 
 

 

Step 3: Configure Record Options 

 
1. Name your audio file. 
 
2. Browse to the location 
where the audio will be saved. 
(By default, files are saved in 
the My Documents folder.) 
 
3. Play a short section of your 
LP or cassette to verify levels 
fall in the OK range. 
 
4. Click Start recording now. 
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Step 4: Stop Recording 
When the end of a side is reached, press the Stop button. 
 

 

Step 5: Splitting Tracks 
Pyro records an entire side of an LP or cassette as one large track. Fortunately, Pyro 
is the one app listed in this guide that provides an easy interface for splitting large 
tracks into smaller ones. Simply find the points in the complete side where the song 
changes, click the grey bar below the track window, and then slide the split marker 
to obtain more precision. 
 
The Split bar appears just above the scrollbar in the image below. 

 

Step 6: Removing Noise 
Pyro contains two separate tools for removing 
noise. The De-click tool works well for 
eliminating noise from vinyl LPs, while the De-
noise tool is used to remove hiss from cassette 
tape recordings. Both work exceptionally well 
with almost no configuration. In fact, I merely 
turned them on, processed my tracks and 
noticed an amazing difference in clarity. 
 
To use the De-click tool, click the De-click 
button and choose De-click options. 
 
Click Listen to what's being removed, and 

then click the Play button in Pyro. Adjust the levels to eliminate more noise as 
necessary. 
 
Uncheck the Listen to what's being removed 
button, then Turn De-Click on. 
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Assuming you like what you hear in the with the De-Click turned on, it's time to 
move to the file saving step. 
 

 
De-noise filtering for cassettes works 
in a similar fashion. Open the De-
noise filtering options by clicking the 
De-noise button and selecting De-
noise options. 
 
Click Listen to what's being 
removed, and then click the Play 
button in Pyro. Adjust the levels to 
eliminate more noise as necessary. 
Uncheck the Listen to what's being 
removed button, then Turn De-Noise 
on. Assuming you like what you hear 
in the with the De-Noise turned on, 
it's time to save your files. 

 
 
 
 

Step 7: Saving Tracks 
Once your track has been split and noise 
removal is in place, it's time to save the 
individual tracks. Cakewalk breaks them 
out, allowing individual tracks to be 
unselected if they aren't intended to be 
kept. 
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Step 8: Recording a CD 
Pyro conveniently includes a burning utility within the application. To record a 
completed project, first select the tracks in the Files view at the bottom of the Pyro 
window. 

 
 
Next, click the Make audio CD tab, and then click the Add button. 

 
 
Click Burn CD, and then insert a blank CD in the burner and click OK. 
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Recording LPs using Adobe Audition 
Adobe list Audition as being version 1.0, which is only partially true. Audition was 
known as Cool Edit Pro until Adobe purchased it in 2003. Cool Edit was widely 
recognized as an easy-to-use multi-track audio editing tool. Adobe made very few 
changes beyond switching the name. Integration with Adobe Premiere and After 
Effects makes it great for editing video for audio. Priced at $299, Audition is among 
the more expensive options outlined here. Great built-in noise reduction makes it an 
outstanding tool for recording analog tracks, if you can find uses for all the other 
features too. 

Step 1: Launch Adobe Audition 
Start/All Programs/Adobe Audition 

Step 2: Verify Sound Card Settings  
1. Click the Options menu and choose Device Properties. 
2. One the Wave Out tab, verify your sound card as the selected output device. 
 

 
3. Click on the Wave In tab to make sure your sound card is selected as the input 
device. 

 
 
4. Click OK. 
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Step 3: Verify Volume Levels  
1. Activate volume monitoring by selecting Options/Monitor Record Level(s) from 
the menu or pressing F10 on the keyboard.  
2. Play something on your turntable. 
 

 
 
If the peak volume of your audio is much greater or less than about -2db, adjust the 
Line In volume slider in your Mixer's Record Control panel until your VU meters peak 
in the -2db range. (If the peak volume is closer to -3db or -1db, the volume is still 
acceptable, but distortion will occur above the 0db threshold.) Most important is to 
make sure you don't have the Line In cranked to the point where you're system isn't 
recognizing audio dynamics. The level should rise and fall with the volume of the 
songs, ranging from as low as -30 to -40dB, all the way up to the -2dB range. 

Step 4: Create Your Project  
Create a new file by choosing File/New 
or by using CTRL+N on the keyboard. 
Since you are ultimately planning to 
burn your recording to CD, you'll want to 
select 44100 as the Sample Rate, Stereo 
as the Channels selection, and 16-bit as 
the Resolution. 

Step 5: Start Recording  
Click the Record button (the red dot) 
and start playing your record. 
 

 

Step 6: Recording Individual Tracks  
Either stop and then restart the record process for each track on the LP, or record 
the whole thing and edit the file to individual tracks when the side of the LP has 
completed. You'll want to save your raw audio tracks before editing them, as a 
precautionary measure. 

Step 7: Audit Your Audio  
Playback a portion of the recorded track, to determine if the sound is acceptable. 

Step 8: Using Noise Reduction 
The Audition Noise Reduction Effect includes two tools for improving the sound of 
recordings of cassettes and LPs. A Click/Pop Eliminator automatically removes noises 
caused by dust and imperfections in LP grooves. Hiss Reduction eliminates the hiss 
commonly associated with recordings from cassettes.  

 
Step 4: Select Project Options 
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Eliminate Clicks and Pops 
1. To use the Click/Pop 
Eliminator, first switch to 
Edit View by clicking the 
button below the File menu. 
 

 
2. From the Effects menu, 
first select Noise 
Reduction, then choose 
Click/Pop Eliminator. 
3. Choose the preset 
configuration that most closely matches your audio. The descriptions are reasonably 
accurate for most common noise issues. 
 
4. Click the Auto Find All Levels, which performs an analysis on your recording.  
 
Following the analysis, click OK, and then listen back to the result. If the noise 
reduction is satisfactory, it's time to save the file. If not, undo the changes and 
reopen the Click/Pop Eliminator to adjust the settings for a better result. 
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Eliminating Tape Hiss 
Hiss Reduction is also accessible in the Edit View. 
 
1. Open Hiss Reduction 
by selecting the Effects 
menu, choosing Noise 
Reduction, and then 
clicking Hiss 
Reduction. 
 
2. Choose a Hiss 
Reduction preset profile 
from the list of presets. 
 
3. Preview the noise 
reduction by clicking the 
Preview button. 
 
4. Adjust settings as 
necessary. If the noise 
reduction is acceptable, click OK.  
 

  
 
 
Just like using the Click/Pop Eliminator, listen to the result to make sure you 
acheive a desirable result. If the result doesn't improve the recording, Undo the 
Hiss Reduction and repeat these steps as necessary until satisfactory results are 
achieved. 
 
As I will echo in many places throughout this guide, in my experience, software noise 
reduction requires some guess work, in order to determine the best sound for your 
particular recording. The final result is a matter of both personal taste, as well as 
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trial and error to achieve desired results. In most cases, the software presets in 
Adobe Audition will provide you with a satisfactory result. 

Step 9: Saving Your Audio  
Save file as Windows PCM (*.wav) for recording to CD-Audio later. 
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Recording LPs using Cool Edit 2000 
 
Cool Edit 2000 is one of the easiest applications for full-featured audio recording. 
Cool Edit Pro was acquired by Adobe and renamed Audition in 2003, with Cool Edit 
2000 and the rest of the product line being discontinued. This section of the guide 
will sound very similar to what appears in the Adobe Audition section because of the 
product similarity. If you already have a copy of Cool Edit 2000, or can find a used 
copy, this is a great tool for recording LPs and cassettes. Some help is still available 
for Cool Edit users in the Adobe forums at adobe.com. 
 

Step 1: Launch Cool Edit 
Start/All Programs/Cool Edit/Cool Edit 
 

Step 2: Verify Sound Card Settings  
1. Click the Options menu and choose Settings. 
2. Click on the Devices tab.  
3. Verify your sound card as the device selected for both Waveform Playback and 
Waveform Record. 
 

 
 

http://www.adobe.com/
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Step 3: Verify Volume Levels  
1. Double-click the VU meters to turn them on (The VU meters are those red lines 
just below the play controls at the bottom of the Cool Edit workspace in the picture 
below).   
2. Play something on your turntable. 
 
If the peak volume of 
your audio is much 
greater or less than 
about -2db, adjust 
the Line In volume 
slider in your Mixer's 
Record Control panel 
until your VU meters 
peak in the -2db 
range. (If the peak 
volume is closer to -
3db or -1db, the 
volume is still 
acceptable, but 
distortion will occur 
above the 0db threshold.) Most important is to make sure you don't have the Line In 
cranked to the point where you're system isn't recognizing audio dynamics. The level 
should rise and fall with the volume of the songs, ranging from as low as -30 to -
40dB, all the way up to the -2dB range. 

Step 4: Create Your Project  
Create a new file by choosing File/New or by using Ctrl+N on the keyboard. Since 
you are ultimately planning to burn your recording to CD, you'll want to select 44100 
as the Sample Rate, Stereo as the 
Channels selection, and 16-bit as the 
Resolution. 

Step 5: Start Recording  
Click the record button (the red dot) 
and start playing your record. 

Step 6: Recording Individual Tracks  
Either stop and then restart the record 
process for each track on the LP, or 
record the whole thing and edit the file 
to individual tracks when the side of 
the LP has completed. You'll want to 
save your raw audio tracks before 
editing them, as a precautionary 
measure. 

Step 7: Audit Your Audio  
Playback at least some portion of the recording, to determine if you like the sound or 
not. 

 
Step 4: Select Project Options 
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Step 8: Using Noise Reduction 
The Cool Edit Audio 
Cleanup plug-in is a great 
investment for cleaning the 
imported LP tracks. The 
Audio Cleanup plug-in 
contains a Click/Pop 
Eliminator, which does an 
outstanding job of 
automatically removing all 
those noises caused by 
dust and imperfections in 
the LP grooves. The 
Click/Pop Eliminator works 
in a simple point-click 
fashion. Simply select 
Transform/Noise 
Reduction/Click/Pop 
Eliminator, as shown below.  
 
With the Click/Pop Eliminator 
open, click the Auto Find All 
Levels, which performs an 
analysis on your recording.  
 
Following the analysis, click OK 
and then listen back to the result. 
If you are satisfied with the sound 
quality after using click/pop 
reduction, save the changes to 
the file. If not, undo the changes 
and reopen the Click/Pop 
Eliminator to adjust the settings 
for a better result. 
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If you recorded audio from a cassette tape, the Hiss Reduction tool will be the 
plug-in you want to use. The Hiss Reduction plug-in has 3 presets that work for most 
tape hiss issues. Select one of the preset Hiss Reductions and then click OK.  
 

 
 
Just like the Click/Pop Eliminator, you'll want to listen back to the result to make 
sure you are happy with the sound after applying the reduction. If the result doesn't 
improve the recording, Undo the Hiss Reduction and repeat these steps as necessary 
until satisfactory results are achieved. 
 
In my experience, software noise reduction requires some guess work, in order to 
determine the best sound for your particular recording. The final result is a matter of 
both personal taste, and some trial and error to achieve desired results. In most 
cases, the software presets in Cool Edit will provide you with a satisfactory result. 

Step 9: Saving Your Audio  
Save file as Windows PCM (*.wav) for recording to CD-Audio later. 
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Recording LPs using Sound Forge  
 
For the purposes of recording your audio tracks from vinyl, both Sound Forge and 
Sound Forge XP Studio are identical in user interface. Sound Forge has considerably 
more functionality, including support for DirectX plug-ins, however, a longer feature 
list comes with a larger price tag, and in most cases you won't use the extra 
features. To download either application for demo or purchase visit Sony Media 
Software online. 

Step 1: Launch Sound Forge 

Step 2: Configure 
Preferences  
1. From the menu, choose 
Options and then select 
Preferences.  
 
2. Click on the Wave tab.  
 
3. Verify your soundcard 
as the device selected for 
both Playback and 
Record. 
 
 
 

 

http://mediasoftware.sonypictures.com/
http://mediasoftware.sonypictures.com/
http://mediasoftware.sonypictures.com/
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Step 3: Prepare to Record  
 
1. Click the 
Record button 
(Ctrl+R on your 
keyboard).  
 
2. Check the 
checkbox next to 
Monitor, so that 
the levels are 
displaying in the 
Record VU 
meters.  
 
3. Play something 
on your turntable.  
 
If the meter peaks 
at anything 
greater or less 
than about -2db, 
adjust the Line In 
volume slider in 
the Mixer's Record 
Control panel until 
your VU meters are peaking in that -2db range. (Anywhere between -3db or -1db is 
acceptable. Volumes peaking consistently above 0db result in distorted sound.) Most 
important is to make sure the Line In isn't cranked to the point where the system 
doesn't recognize a change in audio dynamics. Normal dynamics rise and fall with 
the volume of the song, ranging anywhere from as low as -30 to -40dB, all the way 
up to the -2dB range. 
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Step 4: Start Recording  
1. From the Record window, 
click on the New... button. 
Since the goal is to burn the 
final recording to CD, select 
44,100 as the Sample 
rate, 16 bit as the Bit-
depth, and set the 
Channels to Stereo. Click 
OK when you've adjusted 
these settings. 
 
2. Click the Record button 
(the red dot in the Record 
window or Ctrl+R on the 
keyboard) and start playing 
your record. 

Step 5: Splitting Tracks 
To create individual tracks, either stop and then restart the record process for each 
track on the LP, or record an entire side, and then split the individual tracks when 
the side is completed. 

Step 6: Saving Files 
Save file as Wave 
(Microsoft) (*.wav). 
Choose the Template:  
Stereo, 44,100 Hz, 
16 bit PCM. 
 

Step 7: File Review 
Playback a portion of 
the recording, to 
determine if your 
recording turned out 
as expected. 
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Step 8: Noise Reduction 
Noise Reduction for Sound Forge comes in the form of an additional plug-in, 
downloadable from the Sony Media Software website. Sound Forge XP Studio does 
not have an option to support DirectX plugins. If you are using XP Studio, check out 
information on Ray Gun at the end of this document, or download Cakewalk Pyro 
2003. Both are excellent noise reduction solutions.  
 
As of this writing, the Sound Forge Noise Reduction plugin currently costs US 
$279.97 in downloadable format. It works outstandingly well, but certainly isn't 
priced with consumers in mind. Unfortunately, to make serious use of Sound Forge 
as a tool for cleaning up your imported LP and cassette tracks, you need this tool or 
a similar DirectX noise reduction plug-in from a third party vendor. 
 
The process of cleaning up the noise, once you have the plugin, is reasonably 
straightforward. With the audio track open in Sound Forge, go to DirectX/Click and 
Crackle Removal. Once inside, select one of the preset configurations from the 
Name: drop down list. In most cases, you'll be able to use Default for vinyl 
recordings or More conservative for vinyl recordings, to get your desired result.  
 
If the preset options don't deliver a desirable result, undo your changes, reselect the 
preset and then modify it's settings just slightly with the slider bars, until the Click 
and Crackle plugin eliminates all the noise without distorting the audio track. Once 
you find a custom setting to suit your needs, save those settings using the Save 
As... button, saving you time on the next album you convert. 
 
As an alternative to the Click and Crackle Removal Tool, Sony also includes a Vinyl 
Restoration tool, which is designed to remove clicking and crackling, while also 
dropping out the overall broadband noise common in older recordings. In my 
experience, the Click and Crackle Removal Tool, combined with the basic Sound 
Forge Noise Reduction Tool is a more effective solution than trying to get the all-in-
one Vinyl Restoration plugin to work properly. 
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Recording LPs using Analog Recorder 
 
Plus! Analog Recorder originally shipped as part of the Digital Media Plus! Pack for 
Windows XP. It's no longer supported and will not work with XP SP2. I have kept this 
in the guide purely as a point of reference.  
 
The first part of this tutorial sets up basic parameters for your computer and audio 
source. Now it's time to start the recording process. 
 

Step 1: Launch Analog Recorder 
 
Start/All Programs/Microsoft Plus! Digital Media Edition/Plus! Analog Recorder 
 

 
 
The first screen welcomes you to Analog Recorder and offers quick links to help files. 
Click Next to begin using the application. 
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Step 2: Adjust Your Recording Level. 
 

 
 
Your computer's sound card should already be selected by default in the Sound 
device drop down menu.  
 
The second drop down menu, Input channel, lets you choose the port your record 
player or cassette deck is connected to. Make sure Line In is selected. 
 
At this point, you need to push play on the cassette deck or put the needle on your 
record. Click the Start button on the screen so Analog Recorder can adjust the audio 
level on your system. 
 

 For USB Audio Devices Only 
 
If you are using a USB audio 
device, like the Creative Extigy or 
an Edirol UA-5, like, Analog 
Recorder can't automatically 
adjust the sound level. It does 
auto-adjust the Griffin 
Technology iMic without issue. 
 
 
 
 
 
 
 
 
 

Once the application detects acceptable levels, click Next.
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External Audio Devices 
 
For external devices, manually 
adjust the input volume using the 
Recoding Control screen. The Level 
meter on the right hand side of the 
screen should never be a solid red 
color. The level may jump into the 
red, but should remain in the 
green and yellow zones to prevent 
distortion. 
 
Once volume is adjusted to an 
appropriate level, click Next. A 
box like the one below will pop-
up, informing you levels 
haven't been automatically 
adjusted. If you are 
comfortable with your level 
settings, click Yes. Proceed to 
the next step. 

 

Step 3: Record Your Music 
 
Before clicking the Record button, 
rewind the tape or move the needle 
back to the beginning of your record. 
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Advanced Recording Options 
 
The Advanced button presents the 
options of having Analog Recorder 
automatically split your recording into 
tracks and set the maximum recording 
time. The default maximum recording 
time should be acceptable. If you are 
recording a speech or book on tape, I 
recommend unchecking Automatically 
detect and split tracks. Analog Recorder 

recognizes long pauses in speaking as new tracks, creating many 2-3 second tracks 
you will need to combine later. 
 
If there is a long pause on a cassette or record, like the end of a side, Analog 
Recorder presents a message like this: 
 

 

Step 4: Review and name your tracks 
 
 
 
For 
audio books or speeches, you can divide large tracks into smaller segments, making 
it easier to listen to the recording in smaller blocks. Highlight the track in the list you 
want to split. Click Play or drag the slider to the point in the recording where you 
want the split to occur, and then click the split tracks button.  
 

 
 

For music cassettes and records, include song title, artist name, album, and 
genre for easy cataloging. 
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Splitting tracks is also useful for eliminating silence. If your cassette has a long lead-
time at the beginning (or empty space at the end), find the point where the audio 
starts and click the Split Tracks button at that point. You can then discard the silent 
segment. 
 

Unfortunately, the only 
undo for this process is 
recombining the tracks 
with the Combine Tracks 
feature.  
 
If Analog Recorder 
divided a track 
incorrectly, combine the 
individual tracks using 
the Combine Tracks 
feature. Hold down the 
CTRL key, and then click 
each track you want to 
combine. When all tracks 
are selected, click the 
button with the arrows 
pointing toward each 
other. 

 

Step 5: Clean your tracks 
Typically, you will need both pop 
and hiss removal on vinyl 
records. Cassettes generally 
require hiss removal only. Test 
the cleaning process by clicking 
the preview button, to make 
sure your audio isn't distorted. 
If the audio sounds clean, click 
the Next button. 
 
Reduce Pops - This feature 
removes popping and crackling 
commonly heard on old records, 
giving the audio a cleaner 
sound. 
 
Reduce Hiss - This feature 
eliminates tape hiss from your 
recordings. 
 
 
 Before you clean all your tracks… 

Test the pop and hiss removal with one track first. Once you have a 
combination that sounds good for one track, apply it to all tracks. This saves 
time, preventing the need to re-run the entire process on all tracks. It's still a 
good idea to preview at least 30 seconds of each track making sure they 
sound good.  
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Step 6: Select settings and save tracks 
 
By default, Analog Recorder 
saves tracks in the My Music 
folder. If you catalog your 
music differently, change 
this to the folder where your 
music is stored. 
 
Unless you need to conserve 
hard drive space, I 
recommend leaving the Save 
music at this Quality slider 
on the highest setting. 
 
For easy burning of your 
tracks to CD later, I 
recommend creating a new 
Windows Media playlist 
named for the artist and 
album. 

 

Digital Rights Management (DRM) 
 

This feature is an 
inconvenience if you plan to 
play your files on a computer 
other than the one you created 
the tracks on. In theory it 
keeps people from copying 
your files, in practice it often 
means you will have difficulty 
using them. 
 
DRM configuration options are 
limited, with Microsoft offering 
a limited selection of choices. 
The disclaimer statement is 
presented the first time you 
use Analog Recorder. 
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Advanced File Naming Options 
 
The Advanced button presents naming and organization options making file 
cataloging easier. 

 
Clicking the Advanced button allows you to 
select a naming scheme. File names can be 
based on any combination of track number, 
track name, album title, artist, and/or genre. 
 
Checking Save files to artist sub-folder and 
Save file to album sub-folder automates 
saving files in folders organized by artist and 
album. 
 
After configuring all these settings, click Next. 
 

 

 

 

Step 7: Saving your tracks 
 

 
 
The only thing to do during this step is wait. Analog Recorder must process each 
track and save it as a WMA file. 
 
At this point, you've completed the process of converting your analog audio to 
digital. If you want your file in some format other than WMA, the following steps will 
get you where you want to go. 
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Converting WMA to MP3 
 
There are numerous 
choices for converting 
WMA files to MP3. I 
really like a freeware 
app called WinFF for 
batch processing many 
files. I specifically 
include this in this guide 
because Plus! Analog 
Recorder only outputs 
WMA files and many 
portable devices (like 
the iPod) don't support 
WMA. 
 
After you install WinFF, launch the application and add WMA files you want to 
convert to MP3. Choose MP3 (audio only) in the Convert to option and pick the 
Output folder. Then hit the Convert button and wander off while the application 
chugs through all of your WMA files. This option defaults to 160 kbps, but you can 
configure it for any of the supported MP3 bitrates. 
 

Burning Audio to CD 
 
Spin It Again and Cakewalk Pyro both include a CD burning option integrated in the 
application interface. Audacity, Adobe Audition, Sound Forge, and Cool Edit all 
require you to burn CDs using separate software. Microsoft includes CD burning 
support in Windows Media Player, which is covered below. iTunes also includes CD 
burning support. 
 
After opening Windows 
Media Player, click on 
the Burn tab at the top 
of the interface. Drag 
the album or songs you 
want to burn to CD to 
the burn list on the 
right hand side of the 
application window. 
Insert a blank disk in 
your CD burner. Verify 
Windows Media Player 
is configured to burn 
an Audio CD (not a 
Data CD). Click the 
Start Burn button. 

 

http://topdrawerdownloads.com/download/104928
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